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2 Introduction 

 

Introduction 
MoTeC LTCs (Lambda to CAN) monitor and control Wideband Lambda 
sensors and transmit Lambda readings and diagnostics on a CAN bus. There 
are single channel LTC and Dual channel LTCD available to suit either Bosch 
LSU4.9 or NTK sensors: 

• #61300 – Single Channel Bosch LSU 4.9 Sensor 
• #61301 – Dual Channel Bosch LSU 4.9 Sensors 
• #61304 – Single Channel NTK Sensor 
• #61305 – Dual Channel NTK Sensors 

Up to 32 Lambda sensors can be configured on a single CAN bus using LTCs, 
allowing an ECU or Data Logger to simultaneously monitor multiple Lambda 
sensors. 
Throughout this manual the LTC, LTCD, LTC-NTK and LTCD-NTK will be 
referred to as LTC except where details specific to a particular model are 
discussed.  

Features 
• Accurate Lambda measurement even when the exhaust gas temperature 

is changing rapidly (heating or cooling) 
• Ability to perform free air sensor calibration or use the initial sensor factory 

calibration.  LTC-NTK has the ability to be calibrated against a test gas. 
• Pre-configured to work in a single LTC or LTCD installation, without 

requiring configuration with a PC 
• LTC Manager software to: 

o configure and calibrate all LTCs on the CAN bus 
o display readings and diagnostics 
o configure the CAN transmission address of each LTC 
o control free air calibration 
o update LTC firmware 

Compatibility  
• MoTeC ‘Hundred Series’ ECUs: M400, M600, M800 and M880 
• MoTeC M1 Series ECUs 
• MoTeC Data Loggers: ACL, SDL, SDL3, ADL, ADL2, ADL3, CDL3 and all 

C Series colour Display Loggers (C187 etc.) 
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Accessories 
• #57006 Bosch LSU 4.9 Lambda Sensor 
• #57007 NTK Lambda Sensor 
• #61059 MoTeC UTC - USB to CAN, used to communicate to the PC 

(optional) 
Note: LTC is not compatible with MoTeC's CAN cable (part number 
61021)
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Installation 

LTC Installation 
The LTC can be mounted to a flat surface using the two mounting holes. 
The LTC should be mounted as far as possible from the exhaust to avoid 
excessive heat.  
Note: LTC maximum ambient temperature is 100 °C. 
Use Connector A to connect the single LTC to the Lambda sensor. Use 
connectors A and B to connect the LTCD to two Lambda sensors.  Use the 
Power/CAN Connector to power the LTC and connect to the CAN bus. 
See Appendices for more details.   

Lambda Sensor Installation 
Warning: The Bosch LSU 4.9 Lambda sensors are fitted from the factory with 
a calibrated trimming resistor embedded in the sensor connector. If the factory 
sensor connector is cut off and replaced with another type, the LTC will not 
operate correctly. 
Note: Unlike the Bosch LSU 4.9 the NTK sensors standard connector can be 
removed and replaced by a non-standard connector without affecting the 
performance of the sensor or the LTC-NTK. However, the initial factory 
calibration method will not work as the calibration resistor is built into the 
original connector. In this case Free Air calibration is required.  It is 
recommended that no wiring modification is made to the NTK sensor or LTC-
NTK unless completely necessary.  
The Lambda sensor should be fitted to the exhaust system with the sensor tip 
protruding into the exhaust gas flow. The following considerations should be 
taken into account when fitting the sensor:   
• Place the sensor on an angle between 10 and 90 degrees to the vertical 

with the tip of the sensor pointing down to prevent condensation build up 
between the sensor case and the sensor ceramic. 

• Do not place the sensor in a vertical position; excess heat soak will 
prevent proper operation. 

• Place the sensor at least 1 metre from the exhaust ports to avoid 
excessive heat (recommended). 

• Place the sensor at least 1 metre from the open end of the exhaust system 
to avoid incorrect readings due to outside oxygen (recommended)  
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o Where necessary for shorter exhaust systems the sensor could be 
placed closer to the engine. 

• Place the sensor away from the flame front coming out of the cylinder 
head and away from areas where one cylinder may have more effect than 
another. 

 
 
 
• If possible, do not place the sensor near exhaust slip joints; some designs 

allow air to enter resulting in incorrect readings. 
If the sensor has to be placed near a slip joint, reverse the slip joints to 
reduce the influence of introduced air. 

 

  
Exhaust slip joint design 

Exhaust flow 

Introduced air No air introduced  

Incorrect sensor 
placement 

Correct sensor placement 
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LTC Manager Software Installation 
The LTC Manager software is required for configuration and calibration of LTC 
units. The software must be installed on Windows XP SP3 or later.  The same 
software package is used for the LTC, LTCD, LTC-NTK and LTCD-NTK. 
Note: The LTC Manager software is not required if using a single LTC or 
LTCD unit preconfigured by MoTeC.  

Install LTC Manager Software 
• Go to the MoTeC website at www.motec.com and navigate to downloads 

> software > latest releases > LTC Manager 
• Save the LTC Manager installation file in your preferred location (for 

example desktop) 
• Double click the saved file to run the installer 
• Follow the installation instructions on the Install Wizard 
• To start the program after installation,  

double click the LTC Manager icon on the desktop 
OR 

Click Start > All Programs > MoTeC > LTC > LTC Manager 

Updating Software 
Software updates are available free of charge, giving access to the latest 
features for the life of the device. Download the latest software versions from 
the website and follow the software installation instructions to update to the 
new version. 
To update the associated firmware in the device see Firmware.

http://www.motec.com/
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CAN Bus Interface 

Gateway Devices 
LTC Manager communicates with the LTC devices on the CAN bus via a 
MoTeC gateway device. 
Supported gateway devices include: 
• MoTeC UTC (USB To CAN) connected to the PC via USB. 
• MoTeC M1 ECU (all models) connected to the PC via Ethernet. 
• MoTeC Display Loggers (all C Series Display Loggers, e.g. C185, plus 

ACL, ADL3, SDL3, CDL3) connected to the PC via Ethernet. 

 
The gateway device must be selected in LTC Manager as shown below. For 
gateway devices that have multiple CAN interfaces (e.g. Display Loggers), the 
appropriate CAN bus must also be selected. 

 
The selected gateway and CAN bus are saved and will be used by default the 
next time LTC Manager is run. 
 

CAN Bitrate Settings 
All devices on a CAN bus must be configured to the same CAN bitrate. 
The CAN bitrate setting in LTC Manager (Tools > Options) must be set to 
match the bitrate of the connected CAN bus. 
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CAN Bitrate Conversion Tool 
All LTC devices are initially configured with a 1Mbps CAN bitrate. 
For applications that require a different CAN bitrate, each LTC on the bus must 
be individually converted to operate at the new bitrate.  
Supported bitrates are 1Mbps (default), 500Kbps, 250Kbps and 125Kbps. 
The bitrate conversion tool (Tools > Options) allows an LTC to be converted to 
any of the four supported bitrates (1Mbps, 500Kbps, 250Kbps and 125Kbps). 
Note: During the bitrate conversion, all devices must be removed from the 
CAN bus except for one LTC device and the MoTeC gateway device. 
This is required as the LTC and gateway device change bitrate during the 
conversion process. If any other CAN devices are present then CAN bus 
would be in error, preventing all devices from communicating. 
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Configuration 

Introduction 
LTC Manager is used to individually configure and calibrate the connected 
LTC units. Configuration using LTC Manager is only necessary if installing 
multiple LTC units or if changes to the default settings are required. 
All LTC configuration and calibration operations are performed directly on an 
LTC and configurations are not stored on disk.  
Note: LTC units come pre-configured to suit a single LTC or LTCD unit 
installation using the initial factory sensor calibration.  
The default CAN address for the LTC is hex 460.  
The default CAN addresses for LTCD is hex 460 for Lambda sensor 1 and hex 
461 for Lambda sensor 2.  

Start LTC Configuration 
• Connect the unit to the PC (see Appendix D – Wiring Details) 
• Ensure the unit is powered 
• Start LTC Manager 

o Click the LTC Manager icon on the desktop 
OR 

o Click Start > All Programs > MoTeC > LTC > LTC Manager. 
• Select the correct gateway and CAN bus (see CAN Bus Interface) 
The main LTC Manager window displays the live configuration and status of all 
LTC units present on the connected CAN bus. 
 

Setup 
CAN Address  
The CAN setup determines which CAN address (specified in hex) the LTC 
uses to transmit readings and diagnostic information. The format of the CAN 
messages is described in.  Appendix E – LTC CAN Messages 
Each LTC on a CAN bus must be configured with a unique CAN address. 
See Operation for information on configuring a MoTeC Data Logger or ECU to 
receive LTC CAN messages. 
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LTC 4.9 Unit Setup 
• To open the LTC Setup window, double click the row in the table 

containing the LTC or click the row and click Setup. 

                       
• Select the Recommended Address check box and enter one of the 

addresses in the drop down box to communicate with MoTeC products 
such as Data Loggers or 'Hundred Series' ECUs.  
The recommended address range for LTC messages is hex 460 to hex 
47F. 

OR 
Select the Custom Address check box and enter an address (in hex) for 
interfacing with third party equipment. 

OR 
Select Disabled to prevent an LTC from transmitting CAN messages.  
While disabled an LTC will not heat the sensor or perform Lambda 
measurements.  
Note:  Lambda sensors should not be left in the exhaust system of a 
running engine if they are not being controlled.  A disabled sensor in a 
running engine can be damaged. 

• In the Name area the default name will appear. The default name matches 
the selected CAN Address (LTC1 etc.). If required the user can specify a 
custom name (e.g. Left Bank or Cylinder 4). 

• Click OK. The configuration updates will be sent to the LTC, this may take 
several seconds 
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LTC-NTK Unit Setup 
• To open the LTC Setup window, double click the row in the table 

containing the LTC or click the row and click Setup. 

                        
• Select the Recommended Address check box and enter one of the 

addresses in the drop down box to communicate with MoTeC products 
such as Data Loggers or 'Hundred Series' ECUs.  
The recommended address range for LTC messages is hex 460 to hex 
47F. 

OR 
Select the Custom Address check box and enter an address (in hex) for 
interfacing with third party equipment. 

OR 
Select Disabled to prevent an LTC from transmitting CAN messages.  
While disabled an LTC will not heat the sensor or perform Lambda 
measurements.  
Note:  Lambda sensors should not be left in the exhaust system of a 
running engine if they are not being controlled.  A disabled sensor in a 
running engine can be damaged. 
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• In the Name area the default name will appear. The default name matches 
the selected CAN Address (LTC1 etc.). If required, the user can specify a 
custom name (e.g. Left Bank or Cylinder 4). 

• Select a Standard Sensor type from the drop down menu  
OR 

Select a Custom Sensor 
Note: Custom sensor setups are for advanced users and it is not 
recommended for general use. 

• Select a Standard Output Table, generally Lambda to three decimal 
places 

OR 
Use a Custom Table for another type of fuel, e.g. Diesel.   

• Click OK.  The configuration updates will be sent to the LTC, this may take 
several seconds 

 
LTC-NTK Output Table 
The standard output table for the LTC-NTK is 
for Lambda to three decimal places. It is 
possible for the user to make a custom table to 
suit the Air/Fuel ratio of any fuel. 
When the Edit button is clicked under Output 
Table a table of Normalized Current appears.  
The standard Lambda values appear in the 
Output column, these numbers can be 
modified to reflect Air/Fuel ratio of a specific 
fuel.  See Appendix F for details of common 
fuels.   

       
Custom tables can be saved using the Save 
As button. 
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Richer than Standard Lambda Readings 
The Lambda reading range of the LTC-NTK can be extended by adding extra 
sites to the Standard Table. If the Standard Table is selected (Lambda 3dp), 
the user can select Custom Table, then Edit, which will expose the current 
Lambda Calibration Table. 

 
 
 

 
 
 
 
At the lower end of the table, users can enter their own values for richer 
mixtures. The table will be reordered when Enter is pressed.  

The Save As option is recommended in order to save the modified table with a 
different name. 

NOTE: MoTeC only recommends rich Lambda values down to 0.63La for the 
NTK sensor. While it is possible to enter current values and their subsequent 
Lambda values to the table, this must be based on the user’s own testing. 

The following table is a suggested starting point for richer Lambda readings. 
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This can be added to the MoTeC-provided calibration table in the LTC-NTK 
setup. 

 
 
 
 
 
 
 

Testing should be done to ensure the accuracy of any values entered 
into the table beyond the MoTeC-provided values. 

CAN Collect Functionality 
CAN Collect functionality allows one LTC (the CAN Collect Master) to collect 
CAN data from up to 15 other slave LTCs, and retransmit these Lambda 
readings on a single CAN address (see Appendix E – LTC CAN Messages).  
Note: A CAN Collect Master device will continue to transmit the standard LTC 
messages in addition to the special collect master messages. 
CAN Collect functionality requires only a single CAN address to be configured 
on a MoTeC Data Logger to receive up to 16 Lambda readings. 
See Operation for information on configuring MoTeC Data Loggers or ECUs to 
use CAN Collect. 

Configure Master and Slave Units 
• To configure an LTC as the CAN Collect Master device, select the CAN 

Collect Master check box and select a CAN address.  
The CAN address for the Master device is the address on which the 
collected Lambda values will be retransmitted. This address must end in a 
zero (i.e. hex 460, 470 etc). The recommended address is hex 460. 

• To configure an LTC as a CAN Collect Slave device, clear the CAN 
Collect Master check box and select a CAN address. 
The CAN address for a Slave device must be configured with one of the 
15 addresses following the master address. For example, if the collect 
master address is hex 460, the slave devices must use CAN addresses in 
the range hex 461 to 46F. 

Normalized Ip (mA) Output (Lambda) 

-8.000 0.620 

-9.000 0.605 

-10.000 0.590 

-11.000 0.575 

-12.000 0.560 

-13.000 0.545 
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The Collect column on the main LTC 
Manager Window shows the configuration 
of CAN Collect Masters and Slaves. The 
Master device is always shown as LTC 
unit 1 (Master (1)), and the slave devices 
are shown as LTC units 2 to 16 according 
to the configured CAN address as shown 
in this example. 
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Calibration 
Warning: The Bosch LSU 4.9 Lambda sensors are fitted from factory with a 
calibrated trimming resistor embedded in the sensor connector, if the factory 
sensor connector is cut off and replaced with another type the LTC will not 
operate correctly. 

Note: Unlike the Bosch LSU 4.9 the NTK sensors standard connector can be 
removed and replaced by a non-standard connector without affecting the 
performance of the sensor or the LTC-NTK. However, the initial factory 
calibration method will not work as the calibration resistor is built into the 
original connector. In this case Free Air calibration is required.  It is 
recommended that no wiring modification is made to the NTK sensor or LTC-
NTK unless completely necessary.  

Calibration Methods 
Initial factory calibration  
The default calibration method uses the known characteristics of a new 
sensor that has been factory trimmed.  

Free Air Calibration 
As a sensor ages, the sensor calibration may change. To maintain accurate 
readings, the LTC allows for re-calibration using the known oxygen 
concentration of free air. The free air calibration procedure takes several 
readings with the sensor in free air to calculate new calibration values. 
To perform an accurate free air calibration, the lambda sensor must be 
removed from the exhaust and placed in an open air environment.  
It is recommended to perform the calibration outside of a workshop or dyno 
room as there may be large amounts of hydrocarbons in the atmosphere. 
Contaminated air will result in an incorrect calibration or a failure to 
calibrate.  Wind should also be avoided as it can affect the free air 
calibration.  
Reference Gas Calibration (LTC-NTK only) 
Reference gas samples for different lambda can be purchased (not 
available from MoTeC) for use as a means of calibrating the LTC-NTK.  
This method is provided for but is unlikely to be implemented by most 
users. 

Calibrate the LTC 4.9 Unit 
• Click Calibrate… to open the Gain Calibration window  
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• Select one of the three options available:   

o Initial Factory Sensor Calibration. This is the default value and 
can be used in most cases.  

o Entered Free Air Calibration. A calibration value from a previous 
Free Air Calibration can be entered. 

o Free Air Calibration. A calibration is performed with the sensor in 
free air. To perform the free air calibration: 

- Click Perform Air Calibration 
Note: The calibration process may take several minutes during 
which the calibration progress window is displayed. 

- The new calibration value is displayed. This value should be 
recorded against the serial number of the sensor to enter this 
calibration when the sensor is used with another LTC unit. 

 
- To apply the new calibration click OK. 

 
• Click OK to save the calibration method and settings to the LTC.   
 
Tip: Spare sensors can be air calibrated before an event and tagged with the 
14 digit calibration number. This number can be used in the entered Free Air 
Calibration option for quick replacement of a sensor during the event. 
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Calibrate the LTC-NTK Unit 
• Click Calibrate… to open the Gain Calibration window  

 
• Select one of the four options available:   

o Initial Factory Sensor Calibration. This is the default value and 
can be used in most cases.  

o Entered Gain Factor. A gain factor from a previous Free Air 
Calibration or Reference Gas Calibration can be entered. 

o Reference Gas Calibration.  A Reference Gas Calibration is not 
recommended for normal use as it required calibrated testing gas. 

o Free Air Calibration. A calibration is performed with the sensor in 
free air. To perform the free air calibration: 

- Click Start Free Air Calibration 
Note: The calibration process may take several minutes during 
which the calibration progress window is displayed. 

 
- When the calibration is complete the new calibration value is 

displayed. This value should be recorded against the serial 
number of the sensor to enter this calibration when the sensor 
is used with another LTC unit. 

- To apply the new calibration click OK. 
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• Click OK to save the calibration method and settings to the LTC. 
 
Tip: Spare sensors can be air calibrated before an event and tagged with the 
4 digit calibration number. This number can be used in the Entered Gain 
Factor calibration option for quick replacement of a sensor during the event. 

 
Firmware 
Each version of the LTC Manager software includes a matching firmware 
version that must be sent to the LTC in order to operate correctly. 
The Config Status column in the main LTC Manager window will indicate if 
the firmware version requires updating.  

Update the Firmware 
• Select the LTC row in the main LTC Manager window 
• Click Update Firmware.  

A progress window will be displayed while the firmware is sent to the LTC.
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Operation  

Monitoring LTCs 
The main LTC Manager window shows live readings, diagnostics and LTC 
state information for all connected LTCs. 

 

Sensor Type 
The Sensor Type column shows the sensor type. For an LTC 4.9 the sensor 
type will always be LSU4.9 and for an LTC-NTK the sensor type will be the 
configured type. 

Serial Num 
The Serial Num column shows the unique serial numbers of all connected 
LTCs. An LTCD will be displayed as two LTCs with the same serial number 
but the designators A and B to identify the two sensors. 

Name 
The Name column shows the assigned names of all connected LTCs. The 
displayed name is configured in the Setup dialog. 

Readings 
The Readings column shows live readings of all connected LTCs. The 
readings can be configured to display as either Lambda or AFR (Air Fuel 
Ratio) for a number of different fuels.  
Note: the display units do not affect the units of the transmitted readings in 
CAN messages. 
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Configure display units 
• Select Tools > Options.  
• Choose a predefined stoichiometric AFR for one of various fuels 

OR 
Define a custom AFR by entering a stoichiometric point between 1.0 
and 100.0. 

Display live readings in larger format 
• Select View > Readings or press F5.  

This larger format display provides a useful means of monitoring several 
sensor values while tuning. 
 

 

Sensor State 
The Sensor State column shows the operating state of all connected LTCs.  

Sensor State Description 

Starting LTC hardware is performing a self calibration 

Heating The Lambda sensor is outside the temperature range 
required for measurement 

Running Lambda measurement is active 

Cooling A heater short circuit or a failure to reach operating 
temperature has occurred. The sensor is allowed to 
cool before another attempt at heating. 
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Diagnostics 
The Diagnostics column shows faults and diagnostic information for all 
connected LTCs.   

Diagnostic Description 

Heater short 
circuit (GND) 

A short circuit to ground has been detected in the 
heater wiring 

Heater short 
circuit (Batt+) 

A short circuit to battery+ has been detected in the 
heater wiring 

Heater open 
circuit 

An open circuit has been detected in the heater wiring 

Failed to achieve 
heat 

The measured sensor temperature is not responding 
to sensor heating. This fault may indicate a fault with 
the sensor wiring. 

Sensor short 
circuit 

A short circuit has been detected in the sensor wiring 

Corrupt Firmware The LTC firmware is corrupt. Upgrade the firmware to 
restore operation. 

Incompatible 
Firmware 

The LTC firmware is incompatible with LTC Manager. 
Upgrade the firmware to restore operation. 

LTC Temp 
The LTC Temp column shows live internal temperature readings of all 
connected LTCs.  
Note: The temperature column shows the temperature of the LTC unit, not the 
sensor temperature. 

CAN Address 
The CAN Address column shows the configured CAN addresses (in hex) of all 
connected LTCs.  
To configure the CAN addresses see Setup. 

Collect 
The Collect column shows the configured CAN Collect functionality of all 
connected LTCs. To configure the CAN Collect functionality see Setup. 
A configured CAN Collect Master device is always shown as Master (1). 
Any LTC unit configured with a CAN address within the 15 CAN addresses 
following a Collect Master address will be shown as Slave (x). 
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The number in the collect column (e.g. (3)) refers to the LTC number (1 to 16) 
in the messages transmitted by a Collect Master LTC. 
For more information about CAN Collect, see CAN Collect Functionality 

Config Status 
The Config Status column shows any issues relating to the configuration of the 
connected LTCs.   

Config Status Description 

OK  Config is OK 

Disabled  The LTC has been disabled under the Setup options. 
A disabled LTC will not measure or transmit readings. 

Incompatible 
Config 

The configuration in the LTC is not compatible with 
the firmware in the LTC. A new configuration can be 
sent to the LTC by changing the Setup or Calibration. 

Corrupt Config The configuration in the LTC is corrupt. A new 
configuration can be sent to the LTC by changing the 
Setup or Calibration. 

CAN Address 
Conflict 

Multiple LTC units have been configured with the 
same CAN address. Each LTC must be configured 
with a unique address. 

Device Type 
The Device Type column shows the model of the connected LTC (LTC4.9 or 
LTC-NTK).  

Firmware Version 
The Firmware Version column shows the version of the firmware in each of the 
connected LTCs.  
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MoTeC Data Loggers 
MoTeC Data Loggers include CAN communication templates to receive LTC 
messages from up to 16 LTCs.  
Received Lambda readings and diagnostics can be displayed and logged. 
Refer to the Dash Manager software for more information. 
There are two methods for receiving LTC CAN messages with a logger device: 
o Using One CAN Template Per LTC 

Select the matching template (e.g. LTC #1 (CAN ID 460)) to receive all 
available readings and diagnostics from an LTC. The selected template 
must match the LTC CAN address specified in LTC Manager.  
Receiving full LTC messages provides the most information about an LTC 
and requires one CAN section per LTC in the communications setup. 

o Using LTC CAN Collect Template 
Select the LTC Collect 16 Channel CAN template to receive Lambda 
readings from up to 16 LTCs. The LTCs must be configured in LTC 
Manager for CAN Collect functionality using address hex 460 for the CAN 
Collect Master.  
Receiving CAN collect messages provides only Lambda readings from 
each LTC but only requires one CAN section in the communications setup 
for up to 16 Lambda readings. 
For more information see CAN Collect Functionality. 

 
 Refer to Dash Manager help for details on loading CAN templates. 
 

  



MoTeC Operation 25 

 

MoTeC M1 ECUs 
MoTeC M1 series ECU packages can support up to 32 LTCs. 
LTC configuration is found in M1 Tune under Exhaust > Lambda where LTCs 
can be enabled for Banks, Collectors and individual cylinders. 
 

 
 
LTC devices are configured in M1 Tune by setting the CAN bus, Index and 
LTC Type.  
 
The Index specifies the CAN ID (e.g.. 0x460) used to receive LTC CAN 
messages. The Index for each configured LTC must be unique and must 
match the configured LTC device.  
 
The LTC Type must match the connected LTC Device. 
Type LTC refers to a LTC4.9 device 
Type LTCN refers to a LTC-NTK device 
 
See the package help in M1 Tune for details on lambda setup. 
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MoTeC 'Hundred Series' ECUs 
MoTeC ‘Hundred Series’ ECUs (M400, M600, M800, M880) can be configured 
to receive Lambda measurements from up to 12 LTCs using the existing PLM 
CAN templates in the ECU Manager software.  The M84 ECU can receive two 
channels of Lambda with CAN addresses 460 and 461. 
Received Lambda readings can be used in engine control and logged. 
Refer to the ECU Manager software for more information.   
Note: The ECU only stores the Lambda readings from the LTC messages; 
LTC diagnostic information is not stored. 

Configure Hundred Series ECU Communications for LTC 
• Select Adjust > General Setup > Communication > CAN Setup 
• For single LTC configuration: 

o Select a spare CAN data slot in the range CAN 1 to CAN 6 
o Enter 1 - PLM Receive for CAN Data 

Enter the LTC CAN Address in decimal*. The address must match 
the CAN address specified in LTC Manager. 

• For CAN Collect configuration:  
The LTCs must be configured in LTC Manager for CAN Collect 
functionality using address hex 460 for the CAN Collect Master.  

o Enter 1 - PLM Receive for CAN 6 Data 
o Enter the LTC CAN address in decimal* for CAN 6 address. 

The address must match the CAN address specified in LTC 
Manager for the CAN Collect Master LTC. The recommended 
address is 1120. 

* Important: CAN addresses in ECU Manager are in decimal, while the CAN 
addresses in LTC Manager are in hex. e.g. 1120 decimal = 460 hex 

 Configure M84 ECU Communications for LTC 
• Select Adjust > General Setup > Communication > CAN Setup 
• For single or dual LTC configuration: 

o Enter a CAN Address of 1120 (460 Hex) into the PLM CAN 
Address 

 

Assign Lambda measurements to a Hundred Series channel 
Lambda measurements from the LTCs must be assigned to an ECU channel 
before they can be used for engine control or logging. 
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• Select Adjust > Sensor Setup > Input Setup... to open the Input Pins Setup 
dialog. 

• Attach an LTC reading to a channel, using the following parameters 
 

Input Source Predefined Calibration 

PLM 1 to PLM 12 #81 Lambda: PLM over CAN 

 
Example 1: LTC1 reading assigned to channel Lambda 1 

  
 
Example 2: LTC1 to LTC4 readings assigned to Lambda Cyl channels 

 

Assign Lambda measurements to a M84 channel 
For an M84 the Lambda Input Source is fixed so only the Calibration needs to 
be chosen – Predefined “#81 Lambda: PLM over CAN” 
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Lambda and Air Fuel Ratio  
Lambda gives a measure of the Air to Fuel Ratio (AFR) that is independent of 
the type of fuel being used. 

Lambda 1.00 Stoichiometric ratio: no excess fuel and no excess air 

Lambda > 1.00 Lean: excess air  

Lambda < 1.00 Rich: excess fuel 

Stoichiometric Air Fuel Ratio for various fuels   

Lambda Air Fuel Ratio 

 Petrol Alcohol LPG Diesel 

1.0 14.7 6.4 15.5 14.5 

Calculations with Lambda 

Fuel Stoichiometric 
AFR 

Measured 
value 

Calculated value 

Petrol 14.7 AFR = 14  Lambda = 14/14.7 = 0.95 

Diesel  14.5 Lambda = 1.1  AFR = 1.1 x 14.5 = 16 

See Appendix F – Lambda to Air Fuel Ratio Table for a quick reference table.  

Engine Tuning with Lambda 
When tuning the engine, the target Lambda (or AFR) is dependent on the 
tuning objective. The following table can be used as a guideline. 

Tuning objective Lambda 

Maximum power 0.84 to 0.90 

Economy 1.05  

Emissions 1.00 

Normally the engine is tuned for maximum power at full load and for emissions 
or economy at light loads.  
The exact requirements for a specific engine and fuel can only be found by 
experimentation. On turbo engines extra fuel may be desirable to reduce 
exhaust temperatures and help avoid knock. If the vehicle is fitted with a 
catalytic converter, extra fuel may be required to ensure the catalyst does not 
overheat when not operating at Lambda 1.00  
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Lambda Sensor  
Sensor Warm-up 
The internal heater in the Lambda sensor is powerful enough to allow accurate 
measurement when gas temperature is at room temperature. The sensor will 
take approximately 20 seconds to heat up. 
The maximum continuous operating temperature of the sensor is 850 °C. 
Sensors should not be used at higher temperatures for a prolonged period, 
although the sensor can be heated to 930 °C for a maximum of 10 minutes. 
This may however reduce the accuracy. 

Sensor Lifetime 
The sensor lifetime is dependent on the type of fuel being used and the 
volume of gas flow over the sensor.  
Sensor lifetime will be reduced by contaminants such as silicon, lead, oil, etc. 
Thermal cycling and exposure to exhaust fumes without any heating control 
active will also age the sensor more rapidly.  
Manifold sealants can contaminate sensors. Use sealants that are sensor-
friendly to prevent reduced sensor lifetime.  
When using leaded fuel, sensor element contamination will reduce the sensor 
lifetime substantially. Typically sensor lifetime for high performance engines is 
at least 500 hours in unleaded fuel and 50 hours in leaded fuel. Longer 
lifetimes can be expected for less demanding applications. These figures are a 
conservative estimate as the sensors are designed to be accurate for 50,000 
km of operation in a road car. 
Incorrect placement in the exhaust can overheat the sensor and significantly 
reduce the sensor life. For the Bosch LSU 4.9 the sensor impedance (Ri) is an 
indication of sensor temperature. In normal operation Ri should be 
approximately 300 ohms. If Ri is less than 250 ohms then the sensor is being 
overheated. Ri is included in the transmitted CAN messages.   Due to the 
different control system for the NTK sensor the Ri parameter is not applicable. 
At the end of its life the sensor becomes slow to respond and does not read 
rich properly. Regular performance of the Free Air Calibration (see Calibration) 
will maintain the accuracy of the sensor over its lifetime. 
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LTC Operating Tips 
If the engine misfires for any reason, including an over-rich mixture, the LTC 
may falsely read Lean. This is due to excess air being present in the exhaust 
gasses, caused by incomplete combustion. 
Other areas that can give misleading readings include at high RPM, closed 
throttle when the mixture won’t burn completely. Following overrun fuel cut 
when the sensor has become saturated with oxygen it can take up to several 
seconds to resume accurate readings. Engine misfires include hitting the rev-
limiter, be it a fuel or ignition cut or a combination of both, and can give a 
similar result with time being required to purge the sensor of excess oxygen or 
fuel. 
Engines with high overlap camshafts running at low speed may pump air 
through the engine resulting in a false lean reading, Therefore the LTC may 
need to read leaner than would otherwise be expected. 
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Appendices 

Appendix A – Specifications  
Sensor Type • Bosch LSU 4.9 Lambda sensor (LTC4.9) 

• NTK LZA09 Lambda Sensor 
Power Supply • 11 V - 16 V DC 

• 110 mA typical current plus the sensor heater 
current. 

• Heater current is typically 0.5 A - 1 A (up to 2 A 
on startup) 

Communications • 1 Mbit/sec CAN 
Physical • Dimensions 38 x 26 x 14 mm excluding wiring 

looms and connectors 
• Weight 62 grams 
• Mounting holes spacing 32 mm (Ø3.2 mm) 

Max Temperatures • Max ambient temperature at device 100 °C 
• Max internal device temperature 125 °C 
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Appendix B – Pinout  
Bosch LSU version (LTC 4.9) 

LTC Connector A 
LTCD Connector A and B 
Bosch LSU 4.9 sensor connector 
Mating connector: supplied on sensor 

Pin No Wire Colour Description 

1 Red Ip 

2 Yellow Sensor 0 V 

3 White Heater - 

4 Grey Heater + 

5 Green Ipr 

6 Black Vs 

 

Power/CAN Connector 
DTM 4pin (M) (#68055)  
Mating connector: DTM 4pin (F) (#68054) 

Pin No Wire Colour Description 

1 Black Battery - 

2 Green CAN Lo 

3 White CAN Hi 

4 Red Battery + 
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NTK version (LTC-NTK) 

LTC-NTK Connector A 
NTK sensor connector 
Mating connector: supplied on sensor 

Pin No Wire Colour Description 

1 Blue Heater + 

2 Yellow Heater -  

3 Orange Rc 

4 Black Sensor 0V 

5 N/C  

6 Grey VS 

7 White IP 

8 Black Sensor 0V 

 

Power/CAN Connector 
DTM 4pin (M) (#68055)  
Mating connector: DTM 4pin (F) (#68054) 

Pin No Wire Colour Description 

1 Black Battery - 

2 Green CAN Lo 

3 White CAN Hi 

4 Red Battery + 
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Appendix C – Dimensions  
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Appendix D – Wiring Details 
Power Connections 
Care must be taken for power and ground wiring for the LTC.  Each sensor 
can draw over 3 Amps when cold if multiple channels of Lambda are used this 
current draw will increase dramatically.  Wiring size should be suitable for the 
number of LTCs used.  
Tip: To wire the LTC to power, connect either to the ignition switch for fast 
sensor start up or connect to the fuel pump relay to prevent accidental battery 
drainage  
 

CAN Connections 
Refer to the example below for details on wiring the LTC CAN bus. 
This examples show multiple options (USB and Ethernet) for the PC interface. 
See section CAN Bus Interface for details on PC interfacing. 

 
 

General CAN Bus Wiring Requirements  
The CAN bus should consist of a twisted pair trunk with 100R terminating 
resistors at each end. The preferred cable for the trunk is 100R data cable. 
The maximum length of the bus is 16 metres (50 ft) 
CAN devices (such as MoTeC Data Loggers, ECUs etc) may be connected to 
the trunk with up to 500 mm (20 in) of twisted pair wires.  
An optional CAN connector for the UTC may also be connected to the trunk 
with up to 500 mm (20 in) of twisted wire and should be within 500 mm of one 
end of the trunk.  

10
0R

 100R
 

LTC 

M1 
ECU 

Display 
Logger 

LTC 

 
LTC 

 
LTC 

 

CAN-HI 

CAN-LO 

Ethernet 

UTC 
(optional) 

 

USB 

PC 

PC 

PC 
Ethernet 
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CAN-LO 
 

CAN-HI 
 

10
0R

 100R
 

C
AN

-L
O

 
 C

AN
-H

I 
 

CAN 
Device 

 

500mm 
Max 

C
AN

-L
O

 
 C

AN
-H

I 
 

Optional 
UTC 

Connector 
 

500mm 
Max << CAN Bus >> 

500mm Max 

100R Terminating 
Resistors at each 
end of the CAN Bus 

C
AN

-L
O

 
 C

AN
-H

I 
 

CAN 
Device 

 

C
AN

-L
O

 
 C

AN
-H

I 
 

CAN 
Device 

 

5  4
 

 

These wires must be twisted 
Minimum one twist per 50mm (2in) 

 
 

Short CAN Bus  
If the CAN bus is less than 2 metre (7 ft) long, a single termination resistor 
may be used. The resistor should be placed at the opposite end of the 
CAN bus to the CAN connector.  
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Appendix E – LTC CAN Messages  
Messages 1 and 2 are transmitted by all LTC units. 
Messages 5 to 10 are only transmitted from an LTC unit configured as a CAN 
Collect Master. 

Message 1 
Byte Name Scaling 

0 Compound ID = 0 N/A 
1:2 Lambda Hi:Lo = x.xxxLa 

3:4 Ipn (Normalised pump cell 
current) Hi:Lo = xxxx μA 

5 LTC Internal Temperature xxx °C 

6 Fault bits 

Heater short to Gnd1 
Heater short to VBatt1 
Heater open circuit 
Heater failed to heat1 
Sensor wire short1 
Internal fault1 
Sensor Control fault2 

Bit 0 
Bit 1 
Bit 2 
Bit 3 
Bit 4 
Bit 5 
Bit 6 

7 Heater duty cycle xxx% 
1LTC4.9 only    2LTC-NTK only 

Message 2 
Byte Name Scaling 
0 Compound ID = 1 N/A 

1 Sensor State 

START 
DIAGNOSTICS1 
PRE CAL1 
CALIBRATION 
POST CAL1 
PAUSED 
HEATING 
RUNNING 
COOLING1 
PUMP START2 
PUMP OFF2 

0 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 

2:3 Battery Voltage Hi:Lo  = x.xxV 
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4:5 Ip (Raw pump cell current) Hi:Lo = xxxx μA 

6:7 Ri (Sensor cell impedence)  
(0 for LTC-NTK, not applicable) Hi:Lo = xxxx Ohms 

1LTC4.9 only    2LTC-NTK only 

Message 3 
Byte Name Scaling 
0 Compound ID = 2 N/A 
1 Firmware Version Letter 0..25 = A..Z 
2:3 Firmware Version Number e.g. 104 = v1.04 
4:5 Serial Number  

Message 5 
Byte Name Scaling 
0 Compound ID = 4 N/A 
1 Reserved N/A 
2:3 LTC1 (Master LTC) Lambda Hi:Lo = x.xxxLa 
4:5 LTC2 Lambda Hi:Lo = x.xxxLa 
6:7 LTC3 Lambda Hi:Lo = x.xxxLa 

Message 6 
Byte Name Scaling 
0 Compound ID = 5 N/A 
1 Reserved N/A 
2:3 LTC4 Lambda Hi:Lo = x.xxxLa 
4:5 LTC5 Lambda Hi:Lo = x.xxxLa 
6:7 LTC6 Lambda Hi:Lo = x.xxxLa 

Message 7 
Byte Name Scaling 
0 Compound ID = 6 N/A 
1 Reserved N/A 
2:3 LTC7 Lambda Hi:Lo = x.xxxLa 
4:5 LTC8 Lambda Hi:Lo = x.xxxLa 
6:7 LTC9 Lambda Hi:Lo = x.xxxLa 
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Message 8 
Byte Name Scaling 
0 Compound ID = 7 N/A 
1 Reserved N/A 
2:3 LTC10 Lambda Hi:Lo = x.xxxLa 
4:5 LTC11 Lambda Hi:Lo = x.xxxLa 
6:7 LTC12 Lambda Hi:Lo = x.xxxLa 

Message 9 
Byte Name Scaling 
0 Compound ID = 8 N/A 
1 Reserved N/A 
2:3 LTC13 Lambda Hi:Lo = x.xxxLa 
4:5 LTC14 Lambda Hi:Lo = x.xxxLa 
6:7 LTC15 Lambda Hi:Lo = x.xxxLa 

Message 10 
Byte Name Scaling 
0 Compound ID = 9 N/A 
1 Reserved N/A 
2:3 LTC16 Lambda Hi:Lo = x.xxxLa 
4:5 Reserved N/A 
6:7 Reserved N/A 
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Appendix F – Lambda to Air Fuel Ratio Table 
 

Lambda  Air Fuel Ratio 
 Petrol Alcohol LPG Diesel 

0.70 10.3 4.5 10.9 10.2 
0.75 11.0 4.8 11.6 10.9 
0.80 11.8 5.1 12.4 11.6 
0.85 12.5 5.4 13.2 12.3 
0.90 13.2 5.8 14.0 13.1 
0.95 14.0 6.1 14.7 13.8 
1.00 14.7 6.4 15.5 14.5 
1.05 15.4 6.7 16.3 15.2 
1.10 16.2 7.0 17.1 16.0 
1.15 16.9 7.4 17.8 16.7 
1.20 17.6 7.7 18.6 17.4 
1.25 18.4 8.0 19.4 18.1 
1.30 19.1 8.3 20.2 18.9 
1.35 19.8 8.6 20.9 19.6 
1.40 20.6 9.0 21.7 20.3 
1.45 21.3 9.3 22.5 21.0 
1.50 22.1 9.6 23.3 21.8 
1.55 22.8 9.9 24.0 22.5 
1.60 23.5 10.2 24.8 23.2 
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